
User Manual 
 

for the 
 

Departmental Contracts Information System 

(DCIS) 
 
 
 

 
 
 

2014 
 
 

U.S. Department of Health and Human Services 
Office of the Secretary 

ASAM/OAMP 

  



Departmental Contracts Information System User Manual  
 

VERSION HISTORY 
 

Version # Implemented 
By 

Revision 
Date 

Approved 
By 

Approval 
Date 

Reason 

1.0     Base Document 
1.1 Swain Techs 4/3/2014   Reorganized Document 

New Cover, Major 
revisions to sections 1 
and 2. Combined section 
2 and 3, Added new 
section 3 and began 
section 4.   

1.2 Swain Techs 4/24/2014   Removed Appendices 
Added new Section 3, 
shifted other sections 
completed section 4-5, 
started section 6,  added 
section 8 as placeholder 

1.3 Swain Techs 4/30/14   Current Version, 
Delivered to PMO. 

1.4 Swain Techs 5/5/2014   Added OTAs 
1.5 Swain Techs 7/2/2014   Updated mission 

statement, prepared 
document for website 
deployment. 

2.0 Swain Techs 8/21/14   Updated entire document 
to reflect new DCIS web/ 
application style. 
Removed Google 
Application section 

2.1 Swain Techs 9/11/14   Revised contact 
information and the DCIS 
Front Page section to 
reflect changes on the 
website. 

  

Version 2.1   i 



Departmental Contracts Information System User Manual  
 

TABLE OF CONTENTS 
 

1.0 INTRODUCTION .................................................................................................................. 1 

1.1 DCIS MISSION ................................................................................................................................................. 1 
1.2 SYSTEM OPERATIONS AND MANAGEMENT CONTACTS .................................................................................... 2 

1.2.1 DCIS Support Contacts .......................................................................................................................... 2 

2.0 DCIS OVERVIEW ................................................................................................................ 3 

3.0 ACCESSING THE DCIS FRONT PAGE .......................................................................... 4 

4.0 LOGGING IN TO DCIS ....................................................................................................... 5 

4.1 SETTING A NEW DCIS PASSWORD ON FIRST LOGIN ......................................................................................... 7 
4.2 SUCCESSFUL LOGIN ......................................................................................................................................... 8 

5.0 DCIS VIEW TAB ................................................................................................................... 9 

5.1 ACCESSING DCIS VIEWS ................................................................................................................................. 9 
5.2 VIEW CONTRACT INFORMATION ...................................................................................................................... 9 

5.2.1 Printing Contract Information ............................................................................................................. 11 
5.3 VIEW CONTRACTOR INFORMATION ................................................................................................................ 13 

6.0 DCIS CAR TAB ................................................................................................................... 15 
6.1 ACCESSING DCIS CONTRACTS ...................................................................................................................... 15 
6.2 CREATING A NEW CONTRACT ........................................................................................................................ 15 

6.2.1 Creating an Award – BPA Call ........................................................................................................... 18 
6.2.2 Creating an Award – DCA Definitive Contract Action........................................................................ 19 
6.2.3 Creating an Award – DO Delivery Order ........................................................................................... 21 
6.2.4 Creating an Award – Purchase Order ................................................................................................. 23 
6.2.5 Creating an IDV – Basic Ordering Agreement .................................................................................... 24 
6.2.6 Creating an IDV – Blanket Purchase Agreement ................................................................................ 26 
6.2.7 Creating an IDV – Blanket Purchase Agreement Under Federal Supply Schedule (BPA FSS) .......... 27 
6.2.8 Creating an IDV – GWAC Government Wide Agency Contract .......................................................... 29 
6.2.9 Creating an IDV – IDC Indefinite Delivery Contract .......................................................................... 31 
6.2.10 Creating an OT Agreement – Other Transaction Agreement.......................................................... 32 
6.2.11 Creating an OT IDV – Other Transaction IDV ............................................................................... 33 
6.2.12 Creating an OT-Order Other Transaction Order ........................................................................... 34 
6.2.13 Creating a Modification .................................................................................................................. 36 

6.3 COMPLETING CONTRACTS.............................................................................................................................. 38 
6.3.1 Working through Validations............................................................................................................... 39 
6.3.2 Saving Contract Actions ...................................................................................................................... 41 
6.3.3 Deleting Contract Actions ................................................................................................................... 42 
6.3.4 Printing Contract Information ............................................................................................................. 43 
6.3.5 Viewing FPDS-NG Information ........................................................................................................... 44 
6.3.6 Closing a Contract ............................................................................................................................... 45 

6.4 ACCESSING A COMPLETE (FINAL) CONTRACT ACTION ................................................................................... 45 
6.5 ACCESSING AN UNFINISHED (DRAFT) CONTRACT ACTION ............................................................................. 48 

7.0 DCIS USER PROFILE TAB .............................................................................................. 50 

7.1 ACCESSING DCIS USER PROFILES ................................................................................................................. 50 
7.2 CHANGE PASSWORD ...................................................................................................................................... 50 
7.3 CHANGE PROFILE ........................................................................................................................................... 52 

8.0 DCIS REPORTING/BUSINESS INTELLIGENCE ...................................................... 52 

  

Version 2.1   ii 



Departmental Contracts Information System  User Manual  
 

1.0 INTRODUCTION 
This document is the User Manual for the enhanced Departmental Contracts Information System 
(DCIS) for the Department of Health and Human Services (HHS).  DCIS provides a system for 
processing HHS contract actions, interactively and through Contract Writing Systems (CWSs), 
and reporting them to the Federal Procurement Data System (FPDS). 

DCIS operations are conducted through the following program components: 

• Web Page, Information and Documentation dcis.hhs.gov 

• DCIS Support Team 

• DCIS Application and Database 

• Reports and Business Intelligence 
The DCIS web site contains system documentation, announcements, guidance on specific data 
issues, contact information, and it provides access to the DCIS application. 
The DCIS Support Team may be contacted for assistance in application operations, and data 
issues and clarifications.  The Support Team also assists with report generation, FOIA requests, 
Congressional inquiries, and other items as needed. 
The DCIS application provides a platform for data entry, data lookup and viewing, and 
generation of standard reports.  The application supports web services and provides direct 
interfaces with acquisition systems and FPDS-NG.  All contract actions entered in DCIS 
simultaneously stored in FPDS-NG. 
DCIS provides access to and generation of standard reports.  COGNOS is being implemented as 
the tool for generation of standard reports, ad hoc reports, and data analysis. Additionally custom 
SQL reports can be acquired through DCIS Support. 

1.1 DCIS Mission 
DCIS provides procurement data collection and reporting capabilities to enable the HHS 
Operating Divisions (OPDIVs) to comply with requirements under Public Law 93-400 and FAR 
Subpart 4.6 regarding the reporting of contract actions to the Federal Procurement Data System 
(FPDS).  
DCIS provides a single system capability within HHS that collects, edits, and stores information 
on the individual procurement and contracting actions executed by Operating Divisions 
(OPDIVs) and other offices of HHS. 

Version 2.1  1 

http://dcis.hhs.gov/


Departmental Contracts Information System  User Manual  
 
  

1.2 System Operations and Management Contacts 

1.2.1 DCIS Support Contacts 
Hours:  8:00 AM to 5:00 PM Eastern Standard Time, Monday through Friday, 
excluding Federal Holidays. 

 Telephone: (888) 905-5767 

 Email:  dcis.support@swaintechs.com  

 

To open a support ticket, call or send an email explaining the issue to the DCIS support 
email. 
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2.0 DCIS OVERVIEW  
DCIS is made up of several components that work together with multiple Contract Writing 
Systems (CWSs) to view, retrieve, create, edit, delete, and update contracts which feed into, and 
are stored in and retrieved from the Federal Procurement Data System (FPDS).  The DCIS 
System components are explained below and are illustrated in Figure 2-1. 
 

The DCIS system consists of the following integrated components: 

1. Contract Writing Systems: Multiple CWSs feed data into, and receive data from the DCIS 
system.  The CWSs contain custom interfaces and information that may not be required by 
DCIS and FPDS, but are vital to OPDIV operations.  The majority of DCIS users perform 
most if not all of their contract related duties within their individual Contract Writing 
Systems. 

 

2. DCIS: DCIS is a single system capability within HHS that collects, edits, and stores 
information on individual procurement and contract actions executed by the Operating 
Divisions (OPDIVS) and other Offices.  DCIS receives data from the CWSs as well as from 
FPDS.  It coordinates the communications between them, performs data validation, stores 
HHS required information, and passes required information on to FPDS.   

 

3. DCIS Front Page: The DCIS Front Page is the main user portal and hub.  It contains DCIS 
news and alerts, and information links for users.  It also contains direct links to the DCIS 
application and the DCIS Reporting systems (reporting system in development). 

 

4. DCIS Application: The DCIS Application acts as a user interface where contracts can be 
viewed, created, updated, and deleted without the use of a CWS. It is accessed from the 
DCIS Front Page. 

 

5. DCIS Reporting/ Business Intelligence: DCIS contains systems that provide automatic and 
on demand reports to OPDIVS and individual users. For user generated reports, DCIS is 
currently transitioning away from the older legacy reporting system, to a new reporting and 
Business Intelligence system that will be based outside of the main DCIS application.  The 
DCIS Reports will be accessed directly from the DCIS Front Page.  Additionally, custom 
reports are generated using SQL and are available from DCIS Support. 

 
6. FPDS: DHHS and all other Federal agencies are required to report any contract estimated to 

be worth more than $3000 to the Federal Procurement Data System.  Your individual 
OPDIVs or DHHS will let you know what needs to be reported under that threshold.  DCIS is 
the primary system that handles the FPDS reporting for DHHS.  DCIS applies and enforces 
the FPDS validation and formatting rules to HHS contracts during processing and before they 
are can be saved in FPDS. 

  

Version 2.1  3 



Departmental Contracts Information System  User Manual  
 

 

3.0 Accessing the DCIS Front Page 
The DCIS Front Page is the hub for DCIS user functionality and information. 

1. In a browser, navigate to https://dcis.hhs.gov/ . 

 

2. The DCIS Front Page is the portal to the DCIS application and DCIS Web. 
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Note:  If you do not have a DCIS 
Username, please contact your 
supervisor. 
If you have a DCIS Username, but 
forgot your password, please 
contact DCIS support at 
dcis.support@swaintechs.com 

4.0 Logging in to DCIS 
1. In a browser, navigate to https://dcis.hhs.gov/ . 

 

2. On the DCIS Front Page, click the DCIS-HHS Login 
link. 

 

3. On the next page, read the messages, and then click I AGREE. 
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4. In the DCIS Login window: 

• In the Username field, enter your DCIS username 

• In the Password field, enter your DCIS password 

• Click Login. 
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4.1 Setting a new DCIS Password on First Login 
If this is the first login of a new DCIS account, you will be required to set a new password. 

If not, please continue to 4.2 Successful Login. 

In the Change User Password window: 

• In the Current Password textbox, enter the same password used to login. 

• In the New Password textbox, enter a new password based on the following rules: 

o Cannot be the same as the Username 

o Cannot be the same as the current password 

o Must be at least eight characters long 

o Cannot contain spaces (do not hit the spacebar) 

o Must contain at least one letter, at least one number, and at least one special 
character. 

• In the Re-type New Password textbox, reenter the password you just created. 

• In the Email (Optional) textbox, enter your email, (or leave it blank). 

• Click Submit. 
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4.2 Successful Login 
Once an active Username and Password have been submitted correctly, the DCIS application 
should open with a Welcome (Username) message displayed. 

 

If you have any questions or issues, please contact DCIS support by clicking the 
dcis.support@swaintechs.com link on any DCIS page, or call 888-905-5767. 
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5.0 DCIS View Tab 
The DCIS View tab is accessible to all DCIS users, and provides search and view functionality 
for DCIS contracts as well as Contractor Information. 

5.1 Accessing DCIS Views 
1. Log into DCIS. 

2. Click the View tab. 

 

5.2 View Contract Information 
The contract information screen is used to find and view completed DCIS contracts. 

1. In the View tab, click the Contract Information button. 
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2. In the View Contract Information window fill out at least one of the fields: 

Note: Not all fields are required for a search; filling out more fields helps narrow the search. 

• Contract Number:  Enter all or part of the Contract Number (if known) 

• Order Number: Enter all or part of the Order Number (if known) 

• Procurement Instrument Identifier (PIID): Enter all or part of the PIID (if known) 

• Referenced PIID: Enter all or part of the Referenced PIID (if known) 

• Modification Number: Enter all or part of the Modification number (if known) 

• Agency Code: The agency within which the search will return results (Most users will 
not be able to change this field) 

• Office Code: Select a value from this dropdown to list contracts created by a specific 
office 

Note: Office Code does not narrow down results from the Contract Number field.  If you 
want results from a certain office, select the office from Office Code, and leave the 
Contract Number field blank.  You can search using Office Code and any other 
field. 

Click Search 
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3. In the Results list, click the Contract Number of the contract you would like to view. 

 

4. The View Contract Information screen will display with the contract that was selected. 

 

5.2.1 Printing Contract Information 
If a paper record of the contract is needed, or you would like to view the contract information as 
a form, the Print functionality can be used. 
1. In the View Contract Information window, click the Print button. 

 

  

Version 2.1  11 



Departmental Contracts Information System  User Manual  
 
2. The DCIS Data Collection Sheet will display, and is formatted to print to standard 8.5 X 11 

sized sheets. 
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5.3 View Contractor information 
The Contractor information screen is used to lookup contractor/ vendor information pulled from 
the System for Award Management (SAM) and used in DCIS and FPDS. 
1. In the View tab, click the Contractor information button. 

 

2. In the Contractor Information window fill out at least one of the fields: 

Note: Not all fields are required for a search; filling out more fields helps narrow the search. 

• Contractor Name:  Enter all or part of the Contractor/ Vendor name (if known) 

• DUNS Number: Enter all or part of part of the DUNS Number (if known) 

• Street Address: Enter all or part of the street address of mailing address of the vendor (if 
known) 

• Referenced PIID: Enter all or part of the Referenced PIID (if known) 

• Contractor TIN: Enter all or part of the Contractor’s Taxpayer Information Number (if 
known) 

• City Name: Enter all or part of the name of the city from the contractor/ vendor mailing 
address (if known) 

• Zip Code: Enter all or part of the zip code from the contractor/ vendor mailing address 
(if known) 

• State Code: Select the state from the contractor/ vendor mailing address (if known) 

• Country Code: Select the country the vendor/ contractor is located in (if known) 

Note: The following two fields are searchable, but are not displayed to maintain privacy. 

• Owner’s Name: Enter part or all of the company owner’s name (if known) 

• Owner Phone:  Enter the first three digits (area code) or the entire 10 digit phone 
number of the company (if known) 
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Click Search 

 

 
A list of contractors/ vendors will be displayed based on the information entered in the search 
fields. 
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6.0 DCIS CAR Tab 
The DCIS CAR (Individual Contract Action Report) tab contains the tools needed to edit, create, 
validate, and save HHS contracts.  Only users with the correct permissions can access this tab. 

Note: If you feel you need access to this tab but do not, contact your supervisor or your 
OPDIV helpdesk.  They will need to submit a request to 
dcis.support@swaintechs.com to have your permissions upgraded. 

6.1 Accessing DCIS Contracts 
1. Log into DCIS.  The CAR tab is displayed by default. 

Or: 

2. If you are already in DCIS, click the CAR tab. 

 

 

6.2 Creating a New Contract 
The New Contract Information window is used to create new Awards, IDVS, Orders, and 
Modifications. 

1. In the CAR tab, click the New button.  
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2. In the New Contract Information window, select the type of action to be created from the 

IDV/AWARD Type dropdown menu. 

 

Note: If you are not sure what type of action you need to create, consult with your Contract 
Officer or Supervisor, or contact your OPDIV support desk. 

Award Types 

• AWARD – BPA Call: A call against an existing blanket purchase agreement to request a 
service or product provided under the established agreement. 

• AWARD – DCA Definitive Contract Action: A mutually binding legal relationship 
obligating the seller to furnish the supplies or services (including construction) and the 
buyer to pay for them. It includes all types of commitments that obligate the Government 
to an expenditure of appropriated funds and that, except as otherwise authorized, are in 
writing. 

• AWARD – DO Delivery Order: An order for supplies against an established contract. 

• AWARD – PO <= $25K Purchase Order Less Than Or Equal to $25,000: An offer 
by the Government established to buy supplies or services, including construction and 
research and development, upon specified terms and conditions, using simplified 
acquisition procedures. Use this option for all Purchase Orders that are valued at $25,000 
or less. 

• AWARD – PO > $25K Purchase Order Greater Than $25,000:  Same as above, but 
reserved for Purchase Orders valued at more than $25,000. 
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IDV Types 

• IDV – BOA Basic Ordering Agreement: A written instrument of understanding, 
negotiated between an agency, contracting activity, or contracting office and a contractor, 
that contains (1) terms and clauses applying to future contracts (orders) between the 
parties during its term, (2) a description, as specific as practicable, of supplies or services 
to be provided, and (3) methods for pricing, issuing, and delivering future orders under 
the basic ordering agreement. A basic ordering agreement is not a contract. 

• IDV – BPA Blanket Purchase Agreement: A simplified method of filling anticipated 
repetitive needs for services and products.  BPAs are "charge accounts" that ordering 
offices establish with contractors to provide themselves with an easy ordering tool. 

• IDV-BPA under FSS Blanket Purchase Agreement Under Federal Supply Schedule: 
A Blanker Purchase Agreement under Federal Supply Schedule is a BPA created against 
an existing Federal Supply Schedule Contract. “Ordering activities shall establish the 
BPA with the schedule contractor(s) that can provide the supply or service that represents 
the best value.” 

• IDV – GWAC Government-Wide Agency Contract: A task-order or delivery-order 
contract for information technology established by one agency for Government wide use 
that is operated (1) by an executive agent designated by the Office of Management and 
Budget pursuant to section 5112(e) of the Clinger-Cohen Act, 40 U.S.C. 1412(e); or (2) 
under a delegation of procurement authority issued by the General Services 
Administration (GSA) prior to August 7, 1996, under authority granted GSA by the 
Brooks Act, 40 U.S.C. 759 (repealed by Pub. L. 104-106). A GWAC is a pre-competed, 
multiple-award, indefinite delivery, indefinite quantity (IDIQ) contract that agencies can 
use to buy total IT solutions. 

• IDV-IDC Indefinite Delivery Contract: A vehicle that has been awarded to one or 
more vendors to facilitate the delivery of supply and service orders. 

Other Transactions Types 

• OT- Agreement – Other Transaction Agreement: A contract action made outside of 
the usual Federal procurement regulations.  Can only be created by specially authorized 
users. 

• OT-IDV Other Transaction IDV A task order or delivery order based contract action 
made outside of the usual Federal procurement regulations.  Can only be created by 
specially authorized users. 

• OT-Order Other Transaction Order: Orders placed against internal or external OT-
IDVs.  Can only be created by specially authorized users. 

•  

Modifications 

• Modification: Created to document changes in contract terms and conditions to existing 
contract actions.  
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6.2.1 Creating an Award – BPA Call 
BPA Calls are issued against an existing BPA IDV. 

1. In the CAR tab, click New. 

  

2. From the IDV/Award Type dropdown choose AWARD – BPA Call  BPA Call. 

 

3. The Contract Number field and the Procurement Instrument Identifier (PIID) field are 
used to search for the HHS IDV the BPA Call will be issued against. Fill out all or part of 
either field, and then click Search.  

 

Note: If you are creating a BPA against a Non HHS FSS or GSA contract, enter the entire 
Contract Number, and then click Create BPA under FSS/BPA Call/GSA. Skip to 
step 5. 

4. In the Results table, search for the IDV the BPA will be issued against, and click the link in 
the Contract Number field. 
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5. In the New Contract Information window: 

• From the Agency dropdown, select your agency name or the name of the agency issuing 
the contract (this field will be pre-selected for most users) 

• From the Office dropdown, select your office number or the number of the office issuing 
the contract 

• In the Order Number field, enter the order number 

• In the Mod Number field, enter the modification number if there is one.  If not, leave it 
blank 

• In the Referenced Agency ID field, enter the 4 digit ID of the agency that issued the 
IDV. (This field is pre populated if you used the Search button in step 2. 

6. Click the Create Button. 

 

7. See section 6.3 for information on completing contracts. 

6.2.2 Creating an Award – DCA Definitive Contract Action 
A Definitive Contracts is a mutually binding legal relationship obligating the seller to furnish the 
supplies or services (including construction) and the buyer to pay for them. It includes all types 
of commitments that obligate the Government to an expenditure of appropriated funds and that, 
except as otherwise authorized, are in writing. 
1. In the CAR tab, click New. 

 

Version 2.1  19 



Departmental Contracts Information System  User Manual  
 
2. From the IDV/Award Type dropdown choose AWARD – DCA Definitive Contract 

Action and then click Next. 

 

3. In the New Contract Information window: 

• From the Agency dropdown, select your agency name or the name of the agency issuing 
the contract (This field will be pre-selected for most users) 

• From the Office dropdown, select your office number or the number of the office issuing 
the contract 

• From the Type dropdown, select the type of contract you are creating.  (If you are not 
sure what to select, please consult with your supervisor, or your OPDIV Helpdesk) 

• In the Contract Number field 

o Select the year the contract was awarded 

o Enter the contract number 

• (Optional) In the Order Number field, enter the order number if required 

• (Optional) In the Mod Number field, enter the modification number if there is one.  If 
not, leave it blank 

4. Click the Create Button. 

 

5. See section 6.3 for information on completing contracts. 
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6.2.3 Creating an Award – DO Delivery Order 
A Delivery Order is an order for supplies against an established contract. 

1. In the CAR tab, click New. 

 

2. In the New Contract Information window: 

• From the IDV/Award Type dropdown choose AWARD – DO Delivery Order 

• The Contract Number field and the Procurement Instrument Identifier (PIID) field 
are used to search for the contract the Delivery Order will be issued against. Fill out all or 
part of either field, and then click Search 

 

3. In the Results table, search for the contract the DO will be issued against, and click the link 
in the Contract Number field. 
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4. In the New Contract Information window: 

• From the Agency dropdown, select your agency name or the name of the agency issuing 
the contract (this field will be pre-selected for most users) 

• From the Office dropdown, select your office number or the number of the office issuing 
the contract 

• In the Order Number field, enter the order number 

• In the Mod Number field, enter the modification number if there is one.  If not, leave it 
blank 

• In the Referenced Agency ID field, enter the 4 digit ID of the agency that issued the 
Contract. (This field is usually pre populated) 

5. Click the Create Button. 

 

6. See section 6.3 for information on completing contracts. 
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6.2.4 Creating an Award – Purchase Order 
A Purchase Order is an offer by the Government established to buy supplies or services, 
including construction and research and development, upon specified terms and conditions, using 
simplified acquisition procedures. 

1. In the CAR tab, click New. 

 

2. From the IDV/Award Type dropdown: 

• Choose AWARD – PO <= $25K Purchase Order Less Than or Equal to $25,000 if 
the purchase order being created is for $25,000 or less 

• Choose AWARD – PO > $25K Purchase Order Greater Than $25,000 if the purchase 
order being created for more than $25,000 

 

3. Click Next. 
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4. In the New Contract Information window: 

• From the Agency dropdown, select your agency name or the name of the agency issuing 
the contract (This field will be pre-selected for most users) 

• From the Office dropdown, select your office number or the number of the office issuing 
the contract 

• From the Type dropdown, select the type of contract you are creating.  (If you are not 
sure what to select, please consult with your supervisor, or your OPDIV Helpdesk) 

• In the Contract Number field 
o Select the year the contract was awarded 

o Enter the contract number 

5. Click the Create Button. 

 

6. See section 6.3 for information on completing contracts. 

 

6.2.5 Creating an IDV – Basic Ordering Agreement 
A Basic Ordering Agreement is a written instrument of understanding, negotiated between an 
agency, contracting activity, or contracting office and a contractor, that contains (1) terms and 
clauses applying to future contracts (orders) between the parties during its term, (2) a description, 
as specific as practicable, of supplies or services to be provided, and (3) methods for pricing, 
issuing, and delivering future orders under the basic ordering agreement. A basic ordering 
agreement is not a contract. 
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1. In the CAR tab, click New. 

 

2. From the IDV/Award Type dropdown choose IDV – BOA Basic Ordering Agreement and 
then click Next. 

 

3. In the New Contract Information window: 

• From the Agency dropdown, select your agency name or the name of the agency issuing 
the contract (This field will be pre-selected for most users) 

• From the Office dropdown, select your office number or the number of the office issuing 
the contract 

• From the Type dropdown, select the type of contract you are creating.  (If you are not 
sure what to select, please consult with your supervisor, or your OPDIV Helpdesk) 

• In the Contract Number field 

o Select the year the contract was awarded 

o Enter the contract number 

4. Click the Create Button. 

 

5. See section 6.3 for information on completing contracts. 
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6.2.6 Creating an IDV – Blanket Purchase Agreement 
A Blanket Purchase Agreement is a simplified method of filling anticipated repetitive needs for 
services and products.  BPAs are "charge accounts" that ordering offices establish with 
contractors to provide themselves with an easy ordering tool. 

1. In the CAR tab, click New. 

 

2. From the IDV/Award Type dropdown choose IDV – BOA Blanket Purchase Agreement 
and then click Next. 

 

3. In the New Contract Information window: 

• From the Agency dropdown, select your agency name or the name of the agency issuing 
the contract (This field will be pre-selected for most users) 

• From the Office dropdown, select your office number or the number of the office issuing 
the contract 

• From the Type dropdown, select the type of contract you are creating.  (If you are not 
sure what to select, please consult with your supervisor, or your OPDIV Helpdesk) 

• In the Contract Number field 

o Select the year the contract was awarded 

o Enter the contract number 

4. Click the Create Button. 

 

5. See section 6.3 for information on completing contracts. 
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6.2.7 Creating an IDV – Blanket Purchase Agreement Under Federal Supply 

Schedule (BPA FSS) 
A Blanker Purchase Agreement under Federal Supply Schedule is a BPA created against an 
existing Federal Supply Schedule Contract. “Ordering activities shall establish the BPA with 
the schedule contractor(s) that can provide the supply or service that represents the best 
value.” 

1. In the CAR tab, click New. 

 

2. From the IDV/Award Type dropdown choose IDV-BPA under FSS Blanket Purchase 
Agreement under Federal Supply Schedule. 

 

3. The Contract Number field and the Procurement Instrument Identifier (PIID) field are 
used to search for the HHS FSS contract the BPA FSS will be based on. Fill out all or part of 
either field, and then click Search.  

 

Note: If you are creating a BPA FSS against a Non HHS FSS or GSA contract, enter the 
entire Contract Number, and then click Create BPA under FSS/BPA Call/GSA. 
Skip to step 5. 

4. In the Results table, search for the FSS contract the BPA FSS will be issued against, and 
click the link in the Contract Number field. 
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5. In the New Contract Information window: 

• From the Agency dropdown, select your agency name or the name of the agency issuing 
the contract (this field will be pre-selected for most users) 

• From the Office dropdown, select your office number or the number of the office issuing 
the contract 

• From the Type dropdown, select the type of contract you are creating.  (If you are not 
sure what to select, please consult with your supervisor, or your OPDIV Helpdesk) 

• In the Contract Number field 
o Select the year the contract was awarded 

o Enter the contract number 

• In the Mod Number field, enter the modification number if there is one.  If not, leave it 
blank 

• In the Referenced Agency ID field, enter the 4 digit ID of the agency that issued the FSS 
contract. (This field is pre populated if you used the Search button in step 2. 

6. Click the Create Button. 

 

7. See section 6.3 for information on completing contracts. 
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6.2.8 Creating an IDV – GWAC Government Wide Agency Contract 
A GWAC is a task-order or delivery-order contract for information technology established by 
one agency for Government wide use that is operated (1) by an executive agent designated by the 
Office of Management and Budget pursuant to section 5112(e) of the Clinger-Cohen Act, 40 
U.S.C. 1412(e); or (2) under a delegation of procurement authority issued by the General 
Services Administration (GSA) prior to August 7, 1996, under authority granted GSA by the 
Brooks Act, 40 U.S.C. 759 (repealed by Pub. L. 104-106).  A GWAC is a pre-competed, 
multiple-award, indefinite delivery, indefinite quantity (IDIQ) contract that agencies can use to 
buy total IT solutions. 
1. In the CAR tab, click New. 

 

2. From the IDV/Award Type dropdown choose IDV-GWAC Government-Wide Agency 
Contract and then click Next. 
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3. In the New Contract Information window: 

• From the Agency dropdown, select your agency name or the name of the agency issuing 
the contract (This field will be pre-selected for most users) 

• From the Office dropdown, select your office number or the number of the office issuing 
the contract 

• From the Type dropdown, select the type of contract you are creating.  (If you are not 
sure what to select, please consult with your supervisor, or your OPDIV Helpdesk) 

• In the Contract Number field 
o Select the year the contract was awarded 

o Enter the contract number 

•  (Optional) In the Mod Number field, enter the modification number if there is one.  If 
not, leave it blank 

4. Click the Create Button. 

 

5. See section 6.3 for information on completing contracts. 
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6.2.9 Creating an IDV – IDC Indefinite Delivery Contract 
An Indefinite Delivery contract is a vehicle that has been awarded to one or more vendors to 
facilitate the delivery of supply and service orders. 
1. In the CAR tab, click New. 

 

2. From the IDV/Award Type dropdown choose IDV-IDC Indefinite Delivery Contract and 
then click Next. 

 

3. In the New Contract Information window: 

• From the Agency dropdown, select your agency name or the name of the agency issuing 
the contract (This field will be pre-selected for most users) 

• From the Office dropdown, select your office number or the number of the office issuing 
the contract 

• From the Type dropdown, select the type of contract you are creating.  (If you are not 
sure what to select, please consult with your supervisor, or your OPDIV Helpdesk) 

• In the Contract Number field: 
o Select the year the contract was awarded 

o Enter the contract number 

4. Click the Create Button. 

 

5. See section 6.3 for information on completing contracts. 
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6.2.10 Creating an OT Agreement – Other Transaction Agreement 
An Other Transaction Agreement (OTA) is a contract action made outside of the usual Federal 
procurement regulations.  OTAs can only be created by specially authorized users. 
1. In the CAR tab, click New. 

 

2. From the IDV/Award Type dropdown choose OT – AGREEMENT Other Transaction 
Agreement and then click Next. 

 

3. In the New Contract Information window: 

• From the Agency dropdown, select your agency name or the name of the agency issuing 
the contract (This field may be pre-selected for some users) 

• From the Office dropdown, select your office number or the number of the office issuing 
the contract 

• From the Type dropdown, select the type of contract you are creating.  (For OTAs, 
choose the type of contract that comes closest to the OTA being issued.  For IDVs see 
next section.) 

• In the Contract Number field: 

o Select the year the contract was awarded 

o Enter the contract number 

4. Click the Create Button. 

 

5. See section 6.3 for information on completing contracts. 
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6.2.11 Creating an OT IDV – Other Transaction IDV 
An Other Transaction IDV (OT-IDV) is a task order or delivery order based contract action 
made outside of the usual Federal procurement regulations.  OT-IDVs can only be created by 
specially authorized users. 

1. In the CAR tab, click New. 

 

2. From the IDV/Award Type dropdown choose OT – IDV Other Transaction IDV and then 
click Next. 

 

3. In the New Contract Information window: 

• From the Agency dropdown, select your agency name or the name of the agency issuing 
the contract (This field may be pre-selected for some users) 

• From the Office dropdown, select your office number or the number of the office issuing 
the contract 

• From the Type dropdown, select the type of contract you are creating.  (For OT-IDVs, 
choose the type of contract that comes closest to the IDV being issued.  For contracts see 
the previus section.) 

• In the Contract Number field: 
o Select the year the contract was awarded 

o Enter the contract number 

4. Click the Create Button. 

 

5. See section 6.3 for information on completing contracts. 
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6.2.12 Creating an OT-Order Other Transaction Order 
An Other Transaction Order (OTO) is an order placed against internal or external OT-IDVs.  
OTOs can only be created by specially authorized users. 
1. In the CAR tab, click New. 

 

2. From the IDV/Award Type dropdown choose OT-Order Other Transaction Order and 
then click Next. 

 

3. The Contract Number field and the Procurement Instrument Identifier (PIID) field are 
used to search for the HHS OT- IDV or contract the order will be based on. Fill out all or part 
of either field, and then click Search.  

 

Note: If you are creating a OTA Order against a Non HHS OT-IDV or GSA contract, enter 
the entire Contract Number, and then click Create OTA Order. Skip to step 5. 

4. In the Results table, search for the OT-IDV or contract the OTA Order will be issued against, 
and click the link in the Contract Number field. 
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5. In the New Contract Information window: 

• From the Agency dropdown, select your agency name or the name of the agency issuing 
the contract (this field may be pre-selected for some users) 

• From the Office dropdown, select your office number or the number of the office issuing 
the contract 

• In the Order Number field, enter the order number 

• In the Mod Number field, enter the modification number if there is one.  If not, leave it 
blank 

• In the Referenced Agency ID field, enter the 4 digit ID of the agency that issued the 
Contract. (This field is usually pre populated) 

6. Click the Create Button. 

 

7. See section 6.3 for information on completing contracts. 
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6.2.13 Creating a Modification 
Modifications are changes to contracts that are created to document changes in contract terms 
and conditions to existing contract actions.  
1. In the CAR tab, click New. 

 

2. From the IDV/Award Type dropdown choose Modification. 

 

The New Modification Search window will open. 
3. In the New Modification Search window fill out at least one of the fields: 

Note: Not all fields are required for a search; filling out more fields helps narrow the search. 

• Contract Number:  Enter all or part of the Contract Number (if known) 

• Order Number: Enter all or part of the Order Number (if known) 

• Procurement Instrument Identifier (PIID): Enter all or part of the PIID (if known) 

• Referenced PIID: Enter all or part of the Referenced PIID (if known) 
Click Search 
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4. In the Results list, select the radio button next to the contract you want to modify, and then 

click Create. 

 

5. In the Create New Modification window, add a 4 digit Modification Number, and then 
click Continue to Create. 

Note: Modification Numbers should be 4 digits. Use leading zeroes for any non 4 digit 
numbers. (Ex. 0001, 0016, 0035 and etc.) 

 

6. The information from the base contract will populate many of the fields in the Modification. 
See section 6.3 for information on completing contracts. 
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Note:  If you are not sure what to 
enter in a field/ select from a 
dropdown, contact your supervisor 
or your OPDIV support Desk. 
If DCIS is not working correctly, 
please contact DCIS support at 
dcis.support@swaintechs.com 

6.3 Completing Contracts 
1. Once a base contract type (or modification) is selected, the New Contract Information/ 

Modification window will open.  The Contract Information screen is used to update, 
validate, save, print and delete DCIS contract actions. All contract data entry, verification 
and correction occurs on this screen. 

 

2. In each appropriate field, enter the information for the 
contract that is being recorded. 

• Be careful to transcribe the information exactly. 

3. Certain DCIS fields are greyed out.  These fields are either 
not used for the type of contract that is being created, has 
information that is entered by the system or brought in from 
FPDS, or information that is inherited from the base contract 
or IDV. 

 

 

• All field 13 (13F-13SS) information is inherited from FPDS, and cannot be changed in 
DCIS. 

• If the information in a Greyed-Out field is incorrect, the Base document (contract or 
IDV) will have to be modified for the information to appear correctly in the Modification 
or Order you are working on. 

4. Other fields may contain information that is inherited from the Base document that can be 
edited as needed. 
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5. As you fill out fields, you can click the Verify button to run checks on what was entered, and 

to let you know exactly which fields are required to be filled out for the contract you are 
creating or modifying. 

 

6.3.1 Working through Validations 
Validations are checks that are run against FPDS and HHS rules for contract creation.  
Validations are in place to make sure all required fields are filled out, and that what is entered in 
the fields meets Federal requirements.   Contracts cannot be finalized in DCIS until all validation 
errors are corrected. 

1. Validation checks are run when the Verify, Save, Save Unfinished Record or the FPDS-
NG buttons are clicked. Certain validations also occur automatically while the contract fields 
are being updated. There are two types of validation messages that users will encounter: 

• Pop-up validations will appear during validation checks and when certain fields are filled 
out incorrectly.  They contain instructions about fields that must be filled out, or 
formatting errors within fields. 

 

• Error Message table validations appear if there are errors after the Verify, Save, Save 
Unfinished Record or the FPDS-NG buttons are clicked.  The blue links are errors 
within the contract.  Red text in the Error Message column generally point to errors that 
have to be corrected outside of the contract. 
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2. In the Error Message Table, clicking a blue link will focus the browser on the field that 

needs to be filled out or corrected (unless the field is not updateable in the contract). 

 

3. Once the field is corrected, and one of the Verify, Save, Save Unfinished Record or the 
FPDS-NG buttons is clicked; the contract fields will be revalidated, and if it is acceptable, 
the validation error will no longer display. 

 

4. The contact can be rechecked by clicking the Verify button. Once all errors are corrected, the 
“This action passes the validations.” message will appear.  The contract can now be saved. 

 

Note:  If you do not know how to correct a validation, please consult a Contract Officer, your 
supervisor, your OPDIV helpdesk, or contact DCIS Support at 
dcis.support@swaintechs.com. 
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6.3.2 Saving Contract Actions 
There are two ways to save a DCIS contract; Save /Update Unfinished and Save/Update. Both 
must pass a set of validations before the contract action can be saved in the DCIS system. 

6.3.2.1 Save Unfinished/ Update Unfinished Record (Draft) 
1. Clicking the Save Unfinished Record button will save a contract in unfinished status in 

DCIS, and Draft status in FPDS. 

 

2. Clicking the Update Unfinished Record will save changes to an existing unfinished 
contract, without finalizing it in DCIS and FPDS. 

 

• Unfinished Contracts must pass a very basic set of validations, so if you are not sure 
about certain fields, saving an unfinished contract will allow you to preserve work 
without having to fix all of the validations that are required for a “fully” saved contract. 

• Saving Unfinished will also allow contracts to be partially created, and then completed 
later. 

• Only New contracts and unfinished contracts can be saved or updated as an unfinished 
contract. 

3. To reopen a contract that was saved in unfinished form, see section 6.5 Accessing an 
Unfinished (Draft) Contract Action. 
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6.3.2.2 Save /Update Contract (Final) 
1. Clicking the Save button will convert an unfinished record to “Final” status in DCIS and 

FPDS. 

 

2. The Update button will save changes to a previously saved contract. 

 

• Saving a contract in “Final” status triggers the complete set of validation checks. 

o All validation errors must be fixed before the contract can be finalized. 

• A contract can be saved in “Final” status from creation, as long as all validation errors are 
addressed. 

• A contract action does not move out of Draft status in FPDS until it has been Saved. 
3. To reopen a contract that was saved in “final” form, see section 6.4 Accessing a Complete 

(Final) Contract Action. 

6.3.3 Deleting Contract Actions 
The Delete button can be used to delete a contract action from DCIS and FPDS. 

1. In the Contract Information window of the contract you want to remove, click the Delete 
button. 

Note:  There is no verification step once Delete is clicked.  Be sure you want to completely 
remove the contract action from DCIS and FPDS before you click Delete. 

 

2. The Delete Contract Action confirmation will appear.  Click Close. 
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6.3.4 Printing Contract Information 
If a paper record of the contract is needed, or you would like to view the contract information as 
a form, the Print functionality can be used. 
1. In the Contract Information window, click the Print button. 

 

2. The DCIS Data Collection Sheet will display, and is formatted to print to standard 8.5 X 11 
sized sheets. 

 

Note: Contracts are displayed as-is when the Print button is clicked.  No validations are run 
when printing a contract. 
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6.3.5 Viewing FPDS-NG Information 
The contact information can be viewed in FPDS by clicking the FPDS-NG button. 

1. In the Contract Information window, click the FPDS-NG button. 

Note: All validations must be passed before the FPDS window will display. Clicking FPDS-
NG checks and synchronizes DCIS and FPDS data for the contract. 

 

2. In the FPDS-NG Launch Page, check the FPDS information, and then click Close FPDS-
NG. 
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6.3.6 Closing a Contract 
Closing a contract releases it from being locked from being accessed by other users.  It does not 
save the contract, and if the contract has not been saved, the information will be lost. 
1. In the Contract Information window, click Close. 

 

2. In the pop-up window, click OK. 

 

Note:  Using the Close button prevents contracts from being locked.  If you lock yourself out 
of a contract, it will automatically unlock within 45 minutes.  You can also contact 
DCIS support at dcis.support@swaintechs.com to have the contract unlocked faster. 

 

6.4 Accessing a Complete (Final) contract action 
Once a contract is saved and closed, it can be accessed by using the Change button in the CAR 
Tab. 

1. In the CAR tab, click the Change button. 

 

  

Version 2.1  45 

mailto:dcis.support@swaintechs.com


Departmental Contracts Information System  User Manual  
 
2. In the Edit Contract Information window  fill out at least one of the fields: 

Note: Not all fields are required for a search; filling out more fields helps narrow the search. 

• Contract Number:  Enter all or part of the Contract Number (if known) 

• Order Number: Enter all or part of the Order Number (if known) 

• Procurement Instrument Identifier (PIID): Enter all or part of the PIID (if known) 

• Referenced PIID: Enter all or part of the Referenced PIID (if known) 

• Modification Number: Enter all or part of the Modification number (if known) 

• Agency Code: The agency within which the search will return results (Most users will 
not be able to change this field) 

• Office Code: Select a value from this dropdown to list contracts created by a specific 
office 

Note: Office Code does not narrow down results from the Contract Number field.  If you 
want results from a certain office, select the office from Office Code, and leave the 
Contract Number field blank. 

• Signed Date: Enter the range of dates the contract you are searching for was signed 
within (if known) 

Click Search 
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3. In the Results list, click the Contract Number of the contract you would like to view. 

 

4. The Edit Contract Information screen will display with the contract that was selected. 
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6.5 Accessing an Unfinished (Draft) Contract action 

Unfinished contracts can be accessed by using the Unfinished button in the CAR tab. 

1. In the CAR tab, click the Change button. 

 

2. In the Unfinished Contract Information window  fill out at least one of the fields: 

Note: Not all fields are required for a search; filling out more fields helps narrow the search. 

• Contract Number:  Enter all or part of the Contract Number (if known) 

• Order Number: Enter all or part of the Order Number (if known) 

• Procurement Instrument Identifier (PIID): Enter all or part of the PIID (if known) 

• Referenced PIID: Enter all or part of the Referenced PIID (if known) 

• Modification Number: Enter all or part of the Modification number (if known) 

• Agency Code: The agency within which the search will return results (Most users will 
not be able to change this field) 

• Office Code: Select a value from this dropdown to list contracts created by a specific 
office 

Note: Office Code does not narrow down results from the Contract Number field.  If you 
want results from a certain office, select the office from Office Code, and leave the 
Contract Number field blank. 

Click Search 
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3. In the Results list, click the Contract Number of the contract you would like to view. 

 

4. The Unfinished Contract Information screen will display with the contract that was 
selected. 
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7.0 DCIS User Profile Tab 
The DCIS User Profile tab is accessible to all DCIS users, and is used to update the user profile, 
and change the user’s DCIS password. 

7.1 Accessing DCIS User Profiles 
1. Log into DCIS. 

2. Click the User Profile tab. 

 

 

7.2 Change Password 
The Change Password screen allows DCIS users to change their password as desired. 
1. In the User Profile tab, click the Change Password button. 
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2. In the Change User Password window: 

• In the Current Password textbox, enter your current DCIS password. 

• In the New Password textbox, enter a new password based on the following rules: 

o Cannot be the same as the Username 

o Cannot be the same as the current password 

o Must be at least eight characters long 

o Cannot contain spaces (do not hit the spacebar) 

o Must contain at least one letter, at least one number, and at least one special 
character 

• In the Re-type New Password textbox, reenter the password you just created. 

• Click Submit. 
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7.3 Change Profile 
The Change Profile screen allows users to update their DCIS user profile email and phone 

number. 

1. In the User Profile tab, click the Change Profile button. 

 

2. In the User Profile window, check the Email and Phone Number fields, and update as 
needed. 

• If you make any changes, click Submit. 

 

 

8.0 DCIS Reporting/Business Intelligence 
A new reporting system is being developed for DCIS, and will link directly from the DCIS Front 
Page.  The current DCIS Report tab will be removed. 

 

If you need DCIS reports, or have any other issues with DCIS, please contact DCIS Support at 
dcis.support@swaintechs.com or phone (888) 905-5767. 
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